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Scanning: The Old World Joins the New 
 
So many of us immersed in digital photography only look forward, eagerly awaiting the 
next generation of capture devices, new and improved ways of torturing pixels, and the 
ever expanding gamut and dynamic range of inkjet printers. With all the forward 
momentum, we tend to forget that one of photography’s major purposes is to create 
memories, allowing us to look backward at what was. And for many of us, that means 
drawers of negatives, prints and metal boxes full of slides. 
 

  
 
All this stuff degrades over time, so the contemporary advice is to digitize it for 
enhancement and indefinite preservation. Enter scanners and scanning software – a field 
which retains a steady clientele despite the onslaught of digital capture. A few firms still 
manufacture film scanners and several scanning applications are on the market, of which 
SilverFast remains the most comprehensive.  
 
Readers of this website may recall that back in early 2006 Luminous-Landscape 
published a couple of articles I wrote on techniques for scanning colour negatives and the 
use of SilverFast with my Minolta Scan Elite 5400 scanner. Well, over three years have 
elapsed and several relevant developments occurred in the interval: Lasersoft Imaging 
(LSI) has been developing new and interesting features for SilverFast, new models of 
film scanners were released (in particular the Epson V750 Pro, still available) and Adobe 
Photoshop Lightroom hit the market in February 2007.  
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Taking stock of all these developments, LSI asked me if I would be interested in testing 
new ways of working with SilverFast and writing-up my findings. I considered this an 
interesting challenge, so we agreed they would provide the latest software and I would do 
some poking around with it.  
 
Sounds simple enough, but that began an extensive odyssey into the new world of 
SilverFast, and a loan of an Epson V750, courtesy of Epson America, required because it 
enables access to the scanner’s infrared channel, not possible with my now discontinued, 
but still excellent, Minolta Dimage Scan Elite 5400. After exploring a number of avenues 
I decided it can be safely parsed into a few topics of considerable interest: 
 
(1) SilverFast’s Auto iT8 scanner calibration procedure (slides only); 
(2) SilverFast’s version of HDR in 64-bit mode;  
(3) SilverFast’s new hardware-based dust and scratch removal technology called “iSRD”; 
(4) Performance of the Epson V750 Pro scanner; and 
(5) An integrated workflow between SilverFast and Adobe Photoshop Lightroom. 
 
(1) Auto IT-8 – what it does: owners of recent versions of SilverFast Ai Studio can buy 
both transparency and reflective IT8 targets from LSI. With the IT8 loaded in the frame- 
 

 
 

holder, one presses the Auto IT-8 button in SilverFast and the program takes over, 
scanning the target, generating a profile and loading it as the default scanner profile in 
SilverFast’s colour management system (CMS, in Options). This is an important link in 
the chain of a colour-managed workflow, and the good news is that (a) the process is 
seamless and (b) the profile it generates delivers viable results, comparing the original 
(seen with D50 illumination) with the image preview on a colour managed display. I 
can’t offer accuracy estimates with colorimetric methods, but I do have an eye for 
incoherent outcomes, and these are NOT1. The scanner should deliver a set of numbers 

                                                 
1 In this context, I commend readers to two FOGRA reports providing an independent scientific assessment 
of SilverFast’s IT8 target and process results: http://www.silverfast.com/showdocu/en.html?docu=1151 and 
http://www.silverfast.com/download/docu/fogra-reportnr.23024_en_2009-07-08.pdf 
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reproducing the original reasonably well, so that one has a useable and reliable starting 
point for further editing of the digitized original. SilverFast’s IT8 process does at the very 
least do this.  
 
“Hutchcolor” developed and sells very highly regarded targets for scanner profiling. It is 
of course entirely possible to profile a scanner with a Hutchcolor target and load that 
profile into SilverFast’s CMS as the default profile. However, SilverFast’s auto-profiling 
capability would not be available to do this, because SilverFast targets are bar-coded, 
enabling the program’s internal profiling module to work automatically, eliminating 
sources of user-error. In particular, the automated SilverFast process automatically shuts-
off all colour management settings during the profiling process, thereby allowing for 
correct characterization and profiling of the device itself. Also, with alternative processes, 
one would need other colour management software and reference files to read the data 
and generate the profile. Not having gone this route, I can’t comment on how alternative 
approaches would compare.  
 
(2) What is SilverFast HDR and how does it matter in a scanning/editing workflow? 
When we think HDR, we usually think “high dynamic range” obtained by bracketing 
exposures dedicated to shadows, midtones and highlights, and using Photoshop or 
Photomatix etc. for integrating the image into a well-exposed composite with more tonal 
range than achievable from any single exposure.  
 
SilverFast HDR isn’t this. It’s rather a scan mode designed to scan the maximum tonal 
range the scanner can provide from a single image scan (whether positive or negative) 
without image editing adjustments – kind of a “raw scan” format in high bit-depth which 
one would archive as an un-tampered master file, always available as such for alternative 
image edits or processing pipelines. To be able to use these archival and re-processing 
properties of an image originally scanned in Silverfast Ai Studio, it is necessary to also 
install SilverFast HDR Studio, a companion application which links with SilverFast Ai 
Studio. 
 
SilverFast HDR provides an "off-line scanning" functionality which works like this: I 
scan an image in HDR, so it is "raw" data from the scanner with no image editing 
adjustments capable of being applied, except for whatever Gamma value I had set in 
“Options” (SilverFast program preferences). I save the scan in my hard-drive as such. 
Any time thereafter I can open it up in SilverFast HDR, change the “Image Type” (in the 
program’s Frame tab) from “48 bit HDR Color” to “48 bit Color” (which simply enables 
image editing to occur) edit it, and then "Process" it. Until the “Process” button is pushed, 
all of this is done with meta-data, therefore non-destructive and reversible. The processed 
version goes wherever I save it to on my hard drive, but the original scan remains intact 
(i.e. can be reset to its originally scanned status) for other editing work from it's raw state.  
 
While on this subject, a word about the Gamma setting. Normally, one would enter 1.0 
for a linear rendition, or 1.8~2.2 for a contrast curve. Unlike the case for digital cameras, 
the starting point of a film scan is a Gamma-encoded original. Therefore the usefulness of 
a linear Gamma scan value imposed on a gamma-encoded original may be pondered.  I 
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haven’t – I simply do tests and see what works best for me. I and other practitioners have 
observed that this setting produces rather dense saturated results which require extreme 
adjustments to correct. I have found that using SilverFast’s default setting of Gamma 2.2 
produces the most consistent outcomes (relative to the originals) and consistently useful 
results from which to perform further image adjustments. 
 
When a scan is made in SilverFast Ai Studio in 64-bit HDRi mode2 and then opened in 
SilverFast HDR, one can access the most tangible value-added tool I’ve identified from 
this workflow – iSRD hardware-based dust and scratch removal (discussed in Section 3 
and in Annex 1). After using this tool, one has two basic options: (i) within SilverFast 
HDR select 48-bit Color mode (16 bits for each of the R, G and B channels) and make 
image edits using the maximum available scan data, then export the file to an external 
application such Lightroom or Photoshop for further work (Section 5, below), or (ii) one 
can skip any further image editing in SilverFast and export the HDR file to the external 
application for further processing.  
 
One’s choice of options depends on several factors: user software preferences, 
availability of desired program features, and user perception of relative image quality. 
I’ve experimented with both workflows and say more about the alternatives in Section 5. 
 
(3) What is iSRD? Those of us who’ve scanned old slides and negatives are painfully 
aware of two things: (i) removing dust and scratches manually with the clone and healing 
tools in Photoshop is a time-consuming nightmare, and (ii) using conventional dust and 
scratch filters generally degrades overall resolution, save for laborious masking where 
feasible.  
 
 

 
 

                                                 
2 The file dimension difference between 48 bit Color and 64 bit HDRi Color is that the infra-red channel 
accounts for the extra 16 bits. 



Mark D. Segal Photography & Digital Imaging  2009-12-04 Copyright 2009 5

  
 
 
SilverFast iSRD cuts through this dilemma by using the scanner’s infra-red channel for 
identifying artifacts and setting-up their removal. It does so without affecting overall 
image sharpness – at least as far as I could see at 100% magnification. The reason for this 
is that the use of the infra-red channel allows for quite a precise differentiation between 
debris and image detail. Looking at the illustration above, the left image is a 100% 
magnification of detail before using iSRD, and the right is the same detail after using it.  
 
To take advantage of this capability you need two things: a scanner allowing SilverFast to 
access its infra-red channel  (http://www.SilverFast.com/highlights/hdri-list/en) along 
with SilverFast Ai Studio and SilverFast HDR Studio supporting 64 bit Color HDRi and 
iSRD. Many scanners and versions of SilverFast include SRD (without the “i”), but SRD 
used alone is much less effective at separating debris from photographic content, 
compared with versions giving access to the infra-red channel. SRD and iSRD used 
together is a much better story. 
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The iSRD plus SRD toolset has two very appealing features: firstly, the strength of the 
iSRD debris identification can be adjusted to help insure a good separation between 
debris and photographic detail. Where this has reached a limit which in some instances 
may not be fully satisfactory, while retaining the debris removal of iSRD, one can switch 
into SRD and isolate residual debris on separate layers for custom removal. By 
delineating these layers carefully, one excludes unwanted impacts on image content 
surrounding the debris to be targeted with SRD’s adjustable debris removal controls. This 
allows for stronger debris removal without impacting the desired resolution of 
photographic content. Annex 1 shows the workflow for using iSRD and SRD with the 
Epson V750 Pro scanner, whose infra-red channel is well-supported in SilverFast HDRi 
for both Windows and Mac OSX. If residual bits of debris cannot be removed this way 
without impairing image quality, they can be cloned away in Photoshop afterward.  
 
Those who have large quantities of old transparencies and negatives to scan will find this 
feature-set to be not only very effective, but also a huge time-saver. As well, there is an 
added element of flexibility to this workflow, insofar as the infra-red channel remains 
with the saved HDR scan, so the user has the choice of using iSRD at scan time or any 
time thereafter.  
 
(4) My experience using the Epson Perfection V750 Pro scanner. There are two big 
divides in the scanner world: (i) multi-purpose versus dedicated film scanners and (ii) 
price. Dealing with the latter first, for a great many users, scanners as large and expensive 
as the Imacon/Hasselblad would be out of reach, so I am speaking here of the sub-Imacon 
price divide.. 
 
Turning to flat-bed versus film scanners, there are several factors relevant to the subject 
matter of this article. For one, scanners differ in their ability to handle iSRD in SilverFast. 
SilverFast cannot support the infra-red channel in the Minolta DSE 5400 – a permanent 
limitation because Minolta has vacated the business completely. SilverFast’s access to the 
Nikon Coolscan 5000ED infra-red channel is for now only supported in the Mac version 
of the software; but Lasersoft Imaging will address access in Windows down the road. 
iSRD is available in both the Windows and Mac versions of SilverFast for the Epson 
V750. 
 
One advantage of the flat-bed approach is its ability to load a much larger number of 
images for simultaneous preview and batch scanning than is possible with a film scanner.  
As well, the Epson V750 comes with various holders for different film sizes, something 
that is neither relevant nor possible for 35mm film scanners.  
 
SilverFast provides a fairly effective “find frames” feature for delineating the images in 
these frames, necessary for the batch scanning which SilverFast can do. My experience 
using “find frames” is that it does indeed find them, provided I select the correct item in 
the menu choices of scanner bed layouts which is shown upon pressing the “Find 
Frames” icon; however I found it also necessary to make minor framing corrections to 
achieve perfect congruence between image and frame. One would do this anyhow as part 
of any cropping, which I would do more often than not.  



Mark D. Segal Photography & Digital Imaging  2009-12-04 Copyright 2009 7

While on the subject of “find frames”, I noted in my 2006 articles that the scan frame 
must not be allowed to remain outside the image, otherwise relevant “Auto” settings 
produces unintended results for luminosity and colour balance. The more recent versions 
of SilverFast now include in “Options” (“Auto” tab) a “Find Frames Inset”. This places a 
virtual frame (be it inside or outside the image to an extent which is user-determined), 
such that if one were to set it marginally within the image, this problem would not arise. 
 
Installing the software and drivers was a seamless experience on my Windows XP 
computer for both the Epson and Nikon scanners. I mention this, because it is not always 
the case when installing scanners. Because SilverFast provides the program customized 
to each scanner model, the cooperation and coordination between the software and the 
hardware is intended to be seamless, and so far from my experience, it is. In all the work 
I’ve done for this article, the scanners respond as instructed and there have been no 
crashes or delays of either hardware or software. The Epson scanner in particular works 
very quietly. SilverFast Nikon will not open in Windows XP unless the scanner is not 
only turned on, but also has a piece of film loaded in the correct holder. Then it’s fine. 
 
(5) SilverFast and Lightroom: In Section 2 on HDR, I referenced the idea of an 
integrated workflow between SilverFast and Lightroom. In the work I’ve done with both 
applications, I find this a highly attractive idea – to get the comparative advantage which 
each application offers in its own right. Linking SilverFast with Lightroom provides the 
easiest path to the most convenient and high quality image editing. 
 
I say this in the sense that Lightroom provides quite a few editing features not found in 
SilverFast, amongst the salient being: a permanent history track allowing total “undo-
ability” and amendment of previous adjustments, Adjustment Brush and Gradient for 
local editing, Recovery, Fill, Blacks, Vibrance, Clarity, Black & White conversion and 
split toning. Both programs offer exposure adjustment, a tone curve and HSL colour 
adjustment tools. I don’t sharpen film scans in either program, because it is important to 
reduce grain before sharpening and I usually find it preferable to rely on an industrial 
strength application such as Noiseware or Neat Image run from Photoshop, and thereafter 
do a Capture Sharpen using PKS in Photoshop. I’ll explore the workflow options further 
below, but first we need to get the applications to play together.  
 
For those needing quick results that look sharp, the very latest version of Silverfast now 
provides an automated output sharpening algorithm for HDR scans which automatically 
picks-up the scan resolution and image dimensions from the Frame settings and does an 
optimized sharpening, which can be undone in SilverFast HDR by reverting to the 
original scan. I have not tested this feature in my workflow for reasons mentioned above.  
 
For the benefit of the many people still using film and scanning it, or intending to scan 
legacy collections of slides and negatives, it would be really convenient if SilverFast 
were available as a seamless plug-in or module for Lightroom. (It is, by the way, a plug-
in for Photoshop.) That not being the case, there are at least two workarounds: 
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(1) Scan the media to a folder on the hard-drive, note the name of the folder, then open 
Lightroom and migrate “File>Import Images from Disk”, and select the noted folder. 
This is the simplest, manual approach.  
 
(2) There is, however, a slicker, more automated approach, which essentially treats a 
scanner like a tethered camera and automatically opens the images as they emerge from 
SilverFast HDR into a Lightroom folder set-up. The way to create this structure and 
implement it is fully explained in Annex 2.  
 
That accomplished, let us revert to the question of “what to do where” between the two 
applications. To some extent this is a matter of personal preference. But there are 
objective considerations which could influence one’s choice of workflow. It boils down 
to three fundamental issues:  
 
(1) Value to the user of a non-destructive editing workflow; 
(2) Post-scan editing potential as a function of the luminosity and colour characteristics 
of the incoming file, and  
(3) the relative qualities of the editing tools in terms of what they are and what they 
deliver.  
 
Over-arching all of this, there is also a question about the coherence of tonal 
representation between the two applications, i.e. how does the histogram of a SilverFast 
scan in SilverFast compare with the histogram of the same image opened in Lightroom?  
Both applications work in 16-bit ProPhoto colour space (with SilverFast by choice and 
with Lightroom by default.) My experience working a variety of images between the two 
applications suggests that the histograms for the same image compare quite closely. This 
shows in both the Stockholm Street example (very large tonal range with some highlight 
clipping) and the Child at Ruins example (less extreme tonal range with no clipping). My 
Lightroom import settings are all zero in the exposure panel and linear tone curve.  
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Now, turning to fundamental workflow factor (1), I value a non-destructive editing 
workflow because I often find it desirable to go back to an image and amend it. Having a 
permanent history track with total “undo-ability” and “re-do-ability” is a big deal for me 
and Lightroom offers this, whereas no scanning software I know of provides a 
Lightroom-type of history functionality for the pre-scan adjustments – perhaps a 
suggestion for the future. 
 
A big HOWEVER though is in order here - SilverFast HDR comes the closest to doing 
this, in the sense that an HDR scan archived in SilverFast HDR can always be reverted to 
its original state and reworked then reprocessed without re-scanning. It’s the only 
scanning software on the market I know of which has this capability. However, once an 
image is scanned and exported to another application, all pre-scan adjustments are 
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“baked-in” with respect to further processing in the destination application. So with 
regard to reversibility, it is possible in both SilverFast and Lightroom, but the character of 
it differs between them. In SilverFast HDR one could amend the image edits of the 
archived scan and re-process it without rescanning and then re-open it in say Lightroom 
or Photoshop for further processing. Alternatively, one could process minimally in 
SilverFast and send to Lightroom for most of the editing workflow.    
 
This then raises the question posed by fundamental issue (2), is it true that images which 
start their post-capture processing life “in trouble” (say dense, dark images, or images 
with severe casts) would adjust better in Lightroom if they had an initial set of exposure 
or colour balance adjustments in SilverFast? As there are two kinds of SilverFast images 
(non-HDR and HDR images) this question needs to be addressed for both, by first seeing 
what the tonality difference is between non-HDR and HDR image data scanned in 
SilverFast.  
 
I first tried a “regular” Gamma 2.2 scan in both SilverFast Ai Studio and SilverFast HDR. 
The illustration below indicates that there is extremely little, if any, difference of 
appearance between the left image scanned in HDRi 64 bit colour and the right image 
scanned in 48 bit non-HDRi colour. L*a*b* measurements taken at the four points shown 
in the left image confirm the visual impression, as seen in the table below the illustration.  
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Coordinates HDRi 64 bit Color Non-HDRi 48 bit Color 
X Y L a b L a b 

1.      0.504 8.500 74 1 -1 74 1 -1 
2.      2.005 4.505 5 1 -7 5 1 -7 
3.      1.504 0.502 88 2 2 88 2 1 
4.      1.312 1.499 52 15 8 52 14 8 

 
The same editing adjustments can be done in Studio Ai or HDR. One should not conclude 
from this demo that the scans are the same: they are not, in that the HDRi scan is an 
archival scan with access to the infra-red channel – advantageous as discussed above.  
 
We can now turn to the main question for issue (2) – whether initial adjustment of 
troubled images in SilverFast would improve the potential outcome of further work in 
Lightroom, or one shouldn’t bother and just proceed directly to Lightroom. I thought a 
“contrasty” slide of a dark, narrow street in Stockholm’s ancient quarter is trouble enough 
to test this idea. In the illustration below, there are three versions of the image:  
 

 left - starting point, no adjustment of anything;  
 middle - initial adjustments made in SilverFast, touch-ups in LR; 
 right – all adjustments made in Lightroom directly from the left version. 

 

 
 

The challenge here is to open the shadow areas and improve the colour balance without 
washing-out the highlights and the tonality of the sun-lit buildings.  
  
The fact is, that in cases like this, the differences of results do not overwhelmingly favour 
one workflow over the other. While it may be difficult to perceive in a composite 
illustration on a display, the leap from the unadjusted original directly to the Lightroom 
workflow (right-most image) does show several advantages: 
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 the colour balance came out slightly better in the Lightroom version (looking at 
the road), but matching this in SilverFast could be done quite easily;  

 the Lightroom version has a slightly more luminous tonal ramp in the shaded left-
side facades, achieved with a combination of Fill and Blacks not available in 
SilverFast;  

 the Lightroom version has slightly better behaved highlights in the yellow 
building to the right because I didn’t need to use the tone curve in Lightroom – 
most of the brightening was localized to the dark areas using Fill and Blacks, with 
a moderate exposure increase of 0.85, whereas in SilverFast it was necessary to 
use a fairly steep tone curve plus an exposure adjustment, plus a saturation 
increase to achieve a roughly similar outcome; this treatment had somewhat 
greater impact on the highlights than occurred in Lightroom; finally, the left 
woman with sunglasses stands out a bit better in the Lightroom version because I 
was able to brighten her (a bit, to suit the scene) using the Adjustment Brush, also 
not available in SilverFast.  

 
I should add that the original slide does have reddish walls and a kind of cyan-magenta-
ish roadway (ugh), so the output of the SilverFast calibrated scanner is quite faithful to 
the original. If this image falls into the category of “moderately challenging”, one may 
safely infer there would be even less difference of results between the two workflows 
using “well behaved” images (i.e. non-clipped histograms, dynamic range not so huge 
and colours largely in-gamut).  
 
So I thought it worthwhile further drilling down on this choice with an instance of a 
really badly behaved image: severe generalized under-exposure. The first of the three 
illustrations below shows how the image started life, and it looks very much like this on 
the slide. Ignoring the artistic question of whether one would even want to see much 
background behind and around this sculpture, let us just assume for present purposes one 
does. Which approach produces a better composite result with this objective in mind: pre-
adjusting the image at the scan stage, or sending it unamended to Lightroom? 
 
For the version first edited in SilverFast, I bumped Exposure and Brightness to the 
maximum, brightened the shadow slider to the maximum in the Gradation Curve, and 
further increased brightness levels in the gradation curve to maintain contrast. One 
immediately sees that going any further than I went, which is already very far, would 
simply reveal “99% noise and 1% content”. Then taking this adjusted image into 
Lightroom I implemented some relatively moderate adjustments to Fill, Blacks (not so 
moderate), Vibrance, and the dark ends of the Tone Curve. The result is the middle one 
of the three illustrations below.  
 
For the version sent unedited from SilverFast to Lightroom, I implemented a large 
exposure correction, then (compared with the version first edited in SilverFast):  much 
larger Fill, and much more aggressive brightening of the dark end of the Tone Curve, 
along with a much greater reduction of Vibrance. The result is the third one in the set. 
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Both show a severe amount of scanner noise, inevitable in all those parts where the signal 
to noise ratio is inherently so low. Comparing them, one could say that both are fairly 
similar in terms of the tonality and detail they convey. Looking at them very closely (see 
the screen grabs at 100% magnification below), which may not convey well in this 
presentation format, I would give a slight edge to the version first adjusted in SilverFast. 
It’s a bit cleaner and tighter, with slightly crisper rendition of detail. That said, either 
workflow is capable of delivering roughly similar results.  
 

 
 
Finally, let us revert to the Stockholm Street image, where I gave myself the additional 
challenge of finding what combination of software would give me the best tonal range, 
doing in different ways something I’ll call “RHDR” (for “Revisionist” HDR – alias faux-
HDR, or more bluntly - fake HDR, because it’s just different ways of luminosity blending 
from the same image). I didn’t have a tripod with me when I made these photographs 30 
years ago in the streets of Stockholm. I tried two approaches: (i) make two scans in 
SilverFast, one exposed to lighten the shadows, the other the unadjusted original (with 
dark shadows and good mid-tones) and blend them in Photoshop using a gradient on a 
layer mask, or (ii) send the unadjusted original to Lightroom and use Lightroom’s 
“Graduated Filter” (a.k.a. Gradient) to make two exposures within Lightroom alone.  
 
For approach (i), in SilverFast I used a steep tone curve to lighten the shadows and 
scanned it. Then I scanned the same image with no adjustments. I opened both in 
Photoshop, layered the lightened scan on the dark original and applied a gradient with the 
black mask shielding the central mid-tone area from the lightening in SilverFast, as it 
became too light when the dark areas were brightened. The result is the illustration below 
to the left.  
 
For approach (ii), I imported the original (dark) scan to Lightroom, used Fill and Blacks 
to brighten and maintain contrast in the dark areas, but as the Fill over-brightened the 
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mid-tones, I opened the Graduated Filter, ran it across the mid-tones and adjusted them 
back to their intended brightness. This result is shown in the illustration below to the right. 
 

 
 
Again, both versions are viable, but I prefer the Lightroom one because of the manner in 
which the combination of Fill and Blacks can liven-up “dead” areas of an image with 
both brightness and contrast.  
 
In conclusion on program integration, what all this essentially shows is that program 
synergies can be better exploited in some images than in others, and it’s a good idea to 
work between both for discovering the optimal approach in each case. 
 
Turning to factor (3) – the relative qualities of the toolsets, of course there are tools in 
Lightroom which don’t exist in SilverFast and vice versa, because the programs have 
different emphases. There’s nothing like iSRD in Lightroom because it isn’t a program 
developed for film scanning, and there are fewer image editing tools in SilverFast, 
because it provides what is most relevant for the global improvement of scan quality. The 
tools common to both applications are of course effective and they can produce similar 
results in the hands of experienced users. Different users will have different preferences, 
depending in part on what they are accustomed to using, and in part on which ones the 
program operator finds more user-friendly in each application.  
 
Mark D. Segal, December 2009 (www.markdsegal.com) 
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Annex 1. iSRD Workflow 
 
1. Scan the media in HDRi 64 bit color mode by selecting it in Scan Type (FrameTab); 

 
2. Go to the SilverFast Launcher, select 48 Bit and click on the bar to open SilverFast 
HDR; 

 
 
3. In the VLT Navigator (left side) migrate to the location of the scanned image on the 
hard drive, click and drag it to the lower portion of the Light Table main window. 
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4. Double-click it to open the HDR application tools; 
5. This image may well look dark, because it is a linear gamma scan; if so, you will want 
to brighten it to see the dirt and scratches needing removal;  
6. In the main Frame Tab, make sure 48 Bit Color is selected, do whatever luminosity 
and colour editing you wish in SilverFast at this stage, including image size and 
resolution, and give the file another name if you do not wish to over-write the existing 
dirty file; 
7. On the left side of the scan preview, look for a small button which says “SRD” in blue. 
8. Click once on it, and it should change to an iSRD button with a black “i”; 
9. Click on this button and it will change the “i” to red. 
 



Mark D. Segal Photography & Digital Imaging  2009-12-04 Copyright 2009 18

 
10. Click on it again, and immediately underneath it there will be another button which 
says SRD with a bar under SRD (see arrow in illustration below);  
11. Click on that to open the Dust and Scratch removal dialog; (and don’t ask me why 
four operations are needed to get here – there’s probably a reason, but I don’t know it); 
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12. Press the Preview button to get the sections of the image into the preview window of 
the dialog and the program (yes, I know, a fifth operation, but we’re home now!); 
13. Check the iSRD box (just under the tab which says “Layer 1”); this will enable 
scratch and dirt removal using the infra-red channel; 

  
 

14. Move the Detection slider to the point where the dust and debris has been eliminated; 
15. If some cannot be removed this way, check the SRD box below the iSRD section; 
16. Use the selection tool (arrow points to it in the illustration below) to make a selection 
of the area immediately around the defect(s); a dialog will pop-up asking you to name the 
mask created by this selection (see second illustration below); 
17. Then use the sliders (detection, Defect Size, Intensity) to eliminate the artifact(s) as 
well as feasible; 
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18. Return to the iSRD section by checking the iSRD check box;  
19. Click OK at the bottom of this dialog to accept the iSRD and SRD actions; 
20. Now click on the Process button at the bottom of the Frame Tab;  
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21. The program will prompt you where to save the image, select the folder in your hard 
drive where you wish to place it and click Save. The program will now process the 
cleaned-up and adjusted scan to this location. 
This takes more time to read than to perform once you have the “hang” of it, and it works. 
Very large size debris cannot be removed using iSRD without impairing bits of the image, 
but short of that it sweeps clean while not impairing the image. 
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Annex 2. Procedure for Automated Workflow between SilverFast and Lightroom 
 
1. Create a folder in your hard-drive called for example “Scan Watch”. 
 
2. Create another folder in your hard-drive called for example “SilverFast Output”. 
 
In Lightroom: 
 
3. Go to File>Auto Import>Auto Import Settings…” and configure as follows: check 
Enable Auto Import and click on Auto Import Settings…  The dialog opens.  
 

 
 
(a) For “Watched Folder” click Choose, browse to the hard drive folder “Scan Watch”, 
select it and click OK. 
 
(b) For “Destination” click Choose and browse to “SilverFast Output”, select it and click 
OK. 
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(c) For “File Name” keep “Custom Settings”, click the drop-down pane, click Edit and 
make sure {Filename} is in the large white box.  
 

 
 
(d) For “Information”, add any other information of the type offered which you want 
saved with the image file.  
 
(e) Click OK to accept the whole configuration.  
 
4. In the Library Tab, left side, make sure the Catalog folder “Previous Import” is 
selected. 
 
In SilverFast: 
 
5. From the Frame tab, go to Options>General and uncheck “Show Image After Scan”. 
 

 
 
6. In the Frame tab, give the image you are about to scan a file name (this name will be 
carried through the process). 
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7. When you are ready to scan the image, click Scan. The “Save As” dialog appears. For 
“Save In” select the folder “Scan Watch” and click “Save”.  
 

 
 
The image will scan and after a few moments it will open in Lightroom’s “Previous 
Import” folder, with a thumbnail in the large preview area. I recommend copying it to a 
Collection, then editing the file in Lightroom. When done, if the next stage is another 
application, such as Photoshop, Export the image to whatever other place in your hard-
drive where you want this file to be stored.  
 

 
 

8. Alternatively, if you use the 64-bit HDRi Color scan mode in Studio Ai to be able to 
open the image in SilverFast HDR for clean-up and image adjustments, you also need to 
configure the HDR options (Same as in Step 6 above, but this time in SilverFast HDR.) 
 
9. To open the image in SilverFast HDR, open the VLT, make sure the Navigator tab on 
the left side is active, and migrate to the Sub-Folder “Auto-Imported Photos” which is a 
sub-folder within the “SilverFast Output” folder. This is where the scanned image now 
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sits on your hard-drive. Bring into the HRD VLT Preview window, by dragging it into 
the lower pane, and double-click it to open the SilverFast HDR tool set.  
 

 
 

10. Run iSRD, switch the Scan Type to “48 Bit Color” if you wish to make any other 
image edits in SilverFast HDR (or proceed directly to Lightroom and do all edits there), 
change the file name from the original scan and click “Process”. When the “Save As” 
dialog appears, select the Scan Watch folder as in Step 7 above. The HDRi processed 
image will now open in Lightroom’s “Previous Import” folder, where you can compare it 
with the original scan from SilverFast Studio Ai, before the HDRi processing. 
 

 
 

 


